Computing Overview 2023-2024

Foundation Stage

Access Mini-Mash on Purple Mash as needed to fit planning and current learning — teach children how
to access own Purple Mash account

Beebots used to plan a journey

Use of ipads to access drawing / writing programmes and take own photos / videos.

Classroom computer / laptops to access various packages that support current learning.

Use IWB in class to play games, draw, write — children learn how to change pens, turn pages.




Computing Overview 2023-2024

Year 1
National Curriculum Objectives Strand Unit
Understand what algorithms are; how they are implemented as programs on Computer Science 2,4,5,7

digital devices; and that programs execute by following precise and
unambiguous instructions.

Create and debug simple programs Computer Science 5,7
Use logical reasoning to predict the behaviour of simple programs. Computer Science 5,7
Use technology purposefully to create, organise, store, manipulate and Information Technology 3,6,7,8
retrieve digital content

Recognise common uses of information technology beyond school Digital Literacy 9

Use technology safely and respectfully, keeping personal information private; | Digital Literacy 1

identify where to go for help and support when they have concerns about
content or contact on the internet or other online technologies.

Term Focus / Activities / Resources Knowledge, Skills, Understanding Key Vocab
1 Online Safety and Exploring Purple Mash > Login using username and password. Login
» Become familiar with resources on Purple Mash. Username
> Add pictures and text to work. Log out
> Logout of account after use. My Work
> Begin to develop an understanding of ownership of Password
work online. Avatar
Notification
Tools
Save
Topics
2 Grouping and Sorting / Pictograms > Sort items using a range of criteria. Sort
> Contribute to a class pictogram. Criteria
» Use programs to represent and record results. Pictogram
Data
Collate
3 Lego Builders / Maze Explorers > Follow and create simple instructions. Instruction




> Consider how the order of instructions affect results. | Algorithm
» Understand the function of basic direction keys. Computer
> Understand how to create and debug an algorithm. Program
> Understand how to change and extend an algorithm. g?buf’,
» Set challenges for each other C;‘r:”cef;e
> Complete challenges set by the class. Arrow
Undo
Rewind
Forward
Backwards
Right Turn
Left turn
Debug
Instruction
Algorithm
Animated Story Books » Create a story as an e-book. Animation
> Add to previously saved work. E-book
> Add animation to work. Font
> Add sound to work. File
» Use additional features to enhance their stories such | Sound effect
as: backgrounds and copying and pasting pages. Display Board
» Share e-books on a class display board.
Coding » Understand what coding means in Computing. Action
> Build one and two step instructions using coding Background
cards. Button
> Use the program 2Code to create a simple program. | Character
» Design a scene for a program. Code Block
g prog .
Code Design
» Use code blocks to add characters and make them Coder
move. Coding
» Explore a method to code interactively between Collision Detection
objects. Command
> Use collision detection to make objects perform Object
actions. Design Mode
> Use the sound property. Input

Scale




Program

Properties
When clicked
Stop command
When key
Sound
Spreadsheets Navigate around a spreadsheet. Arrow keys
Add images to a spreadsheet using the image Columns
Technology outside school toolbox. Count tool
Use the ‘speak’ and ‘count’ tools in 2calculate. Lock tool
Walk around the local community and find examples | Speak tool

of technology.
Record examples of technology outside of school

Backspace key
Cells

Delete key
Make cell tool
Spreadsheet
Cursor

Clipart

Image Toolbox
Rows
Technology
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Year 2
National Curriculum Objectives Strand Unit
Understand what algorithms are; how they are implemented as programs on | Computer Science 1
digital devices; and that programs execute by following precise and
unambiguous instructions.
Create and debug simple programs Computer Science 1
Use logical reasoning to predict the behaviour of simple programs. Computer Science 1

Use technology purposefully to create, organise, store, manipulate and
retrieve digital content

Information Technology

3,45,6,7,8

Recognise common uses of information technology beyond school Digital Literacy 5
Use technology safely and respectfully, keeping personal information private; | Digital Literacy 2
identify where to go for help and support when they have concerns about
content or contact on the internet or other online technologies.
Term Focus / Activities / Resources Knowledge, Skills, Understanding Key Vocab
1 Coding » Explain that an algorithm is a set of instructions. Action
» Beginning to understand the Repeat and Timer Algorithm
commands. Bug
» Include a button in their programs. Character
» Explain what debug (debugging) means. Code block
» Plan and use algorithms in programs successfully to Code Design
achieve a result. Command
Debug
Design Mode
Input
Object
Properties
Repeat
Scale
Timer
When clicked
When key
2 Online safety and spreadsheets > Begin to understand how things can be shared Search
electronically. Display Board




» Open and send an email to a 2Respond character. Internet
> Explain what a digital footprint is. Sharing
> Explain what rows and columns are in a spreadsheet. E-mail
» Use copying a pasting to help make spreadsheets. Attachment
pying ap g p p . .
. ) Digital Footprint
» Use tools in a spreadsheet to automatically total Backspace Key
rows and columns. Copy and Paste
» Create a table of data on a spreadsheet. Columns
Cells
Count tool
Delete key
Equals tool
Image Toolbox
Lock tool
Move cell tool
Rows
Speak Tool
Spreadsheet
Questioning » Understand what is meant by a binary tree. Pictorgram
» Understand what is meant by a database. Question
> Use a database to answer simple and more complex | Data
search questions Collate
Binary Tree
Avatar
Database
Effective Searching > Recall the meaning of key internet terms. Internet
> ldentify the basic parts of a web search engine search | Search
page. Search Engine
Creating Pictures > Use “2paint a picture’ to study a range of artistic Impressionism
styles and recreate them. Pointillism
Surrealism
Palette
Share
Template
Making music and Presenting ideas » Use the different sounds within 2Sequence to create | Bpm
a tune. Instrument
> Create two tunes digitally which depict two feelings. | Soundtrack




Create, upload and use their own recorded sounds.
Know that digital content can be represented in
many forms.

Extract information from a 2Connect file to make a
publisher fact file on a nonfiction topic.

Use a variety of software to manipulate and present
digital content and information.

Composition
Music
Tempo
Digitally
Sound effects
Volume
Concept map
Node
Narrative
Quiz
Animated
Audience
Presentation
Non-fiction
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Year 3

» Understand what a variable is in programming.

National Curriculum Objectives Strand Unit

Design, write and debug programs that accomplish specific goals, including Computer Science 1

controlling or simulating physical systems; solve problems by decomposing

them into smaller parts.

Use sequence, selection and repetition in programs; work with variables and Computer Science 1

various forms of input and output

Use logical reasoning to explain how some simple algorithms work and to Computer Science 1

detect and correct errors in algorithms and programs

Understand computer networks, including the Internet; how they can provide | Computer Science 3,4,5,6,7,8

multiple services, such as the World Wide Web; and the opportunities they

offer for communication and collaboration.

Use search technologies effectively, appreciate how results are selected and Information technology 5

ranked, and be discerning in evaluating digital content

Select, use and combine a variety of software (including internet services) on | Information technology 2

a range of digital devices to design and create a range of programs, systems

and content that accomplish given goals, including collecting, analysing,

evaluating and presenting data and information.

Use technology safely, respectfully and responsibly; recognise Digital literacy

acceptable/unacceptable behaviour; identify a range of ways to report

concerns about content and contact.

Term Focus / Activities / Resources Knowledge, Skills, Understanding Key Vocab

1 Algorithms and Programs > Review coding vocabulary that relates to Object, Action

Action, Output, Control and Event. Algorithm
» Use 2Chart to represent a sequential program design. | Bug
» Use the design to write the code for the program Code Block
> Design and write a program that simulates a physical :?ebug
system. Object

Computer simulation
Algorithm




> Create a program with an object that repeats actions | Code design
indefinitely Input
> Know what debugging means. Properties
Selection
Bug
Command
Event
Output
Repeat
Timer
Variable
Using the Internet and Spreadsheets » Know what makes a safe password. Password
» Understand how the Internet can be used to help us | Internet
to communicate effectively. Blog
» Understand how a blog can be used to help us Concept map
communicate with a wider audience. Username
» Consider if what is read on websites is true? To look Websitei
at some ‘spoof’ websites. To create a ‘spoof’ PEGI rating
webpage. <= q
> Learn about the meaning of age restrictions symbols gzlrgc:r:(esasm
on digital media and devices.
] Move cell tool
» Create pie charts and bar graphs. Columns
» Use the ‘more than’, ‘less than’ and ‘equals’ tools. Equals tool
Rows
Cells
Spin tool
Spreadsheet
Touch typing » Understand the correct way to sit at the keyboard. Posture

» To learn how to use the home, top and bottom row
keys.

> Practise the keys typed with the left hand.

> Practise the keys typed with the left hand.

> Practise the keys typed with the right hand.

Bottom row keys
Top Row Keys
Space bar

Home row keys

Communicating

» Open and respond to an email.
» Write an email to someone, using an address book.

Communication
Send
Formatting




> Learn how to use email safely. E-mail
> Add an attachment to an email. cC
Report to the teacher
Compose
Attachment
Password
Address book
Save to draft
Databases and simulations » Complete a branching database. Branching database
» Create a branching database Data
> Look at what simulations are. Database
> Explore a simulation. O?uestio.n
» Analyse and evaluate a simulation. Simulation
Graphing » Enter datainto a graph and answer questions. Graph
» Solve an investigation and present the results in Field
graphic form Data
Bar chart
Block graph

Line graph.
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Year 4

National Curriculum Objectives Strand Unit

Design, write and debug programs that accomplish specific goals, including Computer Science 1,5

controlling or simulating physical systems; solve problems by decomposing

them into smaller parts.

Use sequence, selection and repetition in programs; work with variables and Computer Science 1,5

various forms of input and output

Use logical reasoning to explain how some simple algorithms work and to Computer Science 1,5

detect and correct errors in algorithms and programs

Understand computer networks, including the Internet; how they can provide | Computer Science 2,7,8

multiple services, such as the World Wide Web; and the opportunities they

offer for communication and collaboration.

Use search technologies effectively, appreciate how results are selected and Information technology 7

ranked, and be discerning in evaluating digital content

Select, use and combine a variety of software (including internet services) on Information technology 1,3,4,6,9

a range of digital devices to design and create a range of programs, systems

and content that accomplish given goals, including collecting, analysing,

evaluating and presenting data and information.

Use technology safely, respectfully and responsibly; recognise Digital literacy 2

acceptable/unacceptable behaviour; identify a range of ways to report

concerns about content and contact.

Term Focus / Activities / Resources Knowledge, Skills, Understanding Key Vocab

1 Coding » Use repeat instructions on characters. Action
> Experiment with variables to control models. Code Design
» Create if/else statements. Debug/Debugging
» Make turns specifying the degrees. Flowchart Bug
» Understand and use variables. If/Else
» Give an on-screen robot specific directional Repeat

instructions. Simulation
» Make accurate predictions about the outcome of a Alert
program they have written Control




Design Mode
Get input
Input
Selection
Timer
Algorithm
Command
Event

If

Object
Computer simulation
Variable

Online Safety and Spreadsheets

Understand the need for rules to keep them safe
when exchanging learning and ideas online

Identify possible risks of installing free and paid for
software

Determine whether activities that they undertake
online, infringe another’s’ copyright. They know the
difference between researching and using
information and copying it

Take more informed ownership of the way that they
choose to use their free time digitally.

Use the number formatting tools

Add a formula to a cell to automatically make a
calculation in that cell.

Use a series of data in a spreadsheet to create a line
graph.

Computer virus
Cookies
Copyright
Digital footprint
Email

Identify theft
Malware
Phishing
Plagiarism
Spam

Average
Advance mode
Copy and paste
Columns

Cells

Charts

Equals tool
Formula
Formula wizard
Move cell tool
Random tool
Rows

Spin tool
Spreadsheet
Timer




Spreadsheets (finishing) and Writing for audiences. Use text formatting to make a piece of writing fit for | Font
its audience and purpose. Bold
Use a range of word processing tools. Italic
Underline
Logo Know what the different instructions are in Logo and | LOGO
how to type them BK
Follow simple instructions to create shapes in Logo FD
Create shapes using the Repeat function. RT
LT
Repeat
SETPC
SETPS
PU
PD
Animation Understand the use of frames. Animation
Use backgrounds and sounds to make more complex | Background
and imaginative animations Frame
Use ideas from existing stop motion films to recreate | Flipbook
their own animation Onion skinning
Stop motion
Play
Sounds
Video clip
Effective searches and Investigating Hardware Structure search queries to locate specific Easter egg
information. Internet
Analyse the contents of a web page for clues about Internet browser
the credibility of the information Search
Name the different parts of a desktop computer Website

Know what the function of the different parts of a
computer is

Search engine
Spoof website
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Year 5

ranked, and be discerning in evaluating digital content

National Curriculum Objectives Strand Unit
Design, write and debug programs that accomplish specific goals, including Computer Science 1,5
controlling or simulating physical systems; solve problems by decomposing

them into smaller parts.

Use sequence, selection and repetition in programs; work with variables and Computer Science 1
various forms of input and output

Use logical reasoning to explain how some simple algorithms work and to Computer Science 1
detect and correct errors in algorithms and programs

Understand computer networks, including the Internet; how they can provide | Computer Science 2
multiple services, such as the World Wide Web; and the opportunities they

offer for communication and collaboration.

Use search technologies effectively, appreciate how results are selected and Information technology Various.

Search technologies are
taught more in unit 7.

Select, use and combine a variety of software (including internet services) on Information technology 1,3,4,5,6,7,8
a range of digital devices to design and create a range of programs, systems
and content that accomplish given goals, including collecting, analysing,
evaluating and presenting data and information.
Use technology safely, respectfully and responsibly; recognise Digital literacy 2
acceptable/unacceptable behaviour; identify a range of ways to report
concerns about content and contact.
Term Focus / Activities / Resources Knowledge, Skills, Understanding Key Vocab
1 Coding » Create code that conforms to their design. Action

» Explain how their program simulates a physical Bug

system. Control

» Set/change the variable values appropriately. Event

» Create a game which has a timer and score pad. If/Else

» Create loops using the timer and If/else statements. Alert

Code Design

Debug/Debugging




Get input
Input
Algorithm
Command
Design mode
If

Object
Output
Repeat
Selection
Simulation

Online Safety / Spreadsheets

YV V

YV V V

Know who to tell if they are upset by something that
happens online.

Use the SMART rules as a source of guidance when
online.

Think critically about what they share online.

Have clear ideas about good passwords.

Can cite all sources when researching and explain the
importance of this.

Create formulae to solve conversions.

Create simple formulae that use different variables.
Use a spreadsheet to model a real-life situation.

Online safety
Smart rules
Password
Reputable
Encryption
Identity theft
Shared image
Plagiarism
Citations
Reference
Bibliography
Average
Advanced
Copy and paste
Columns
Cells

Charts

Equals
Formula
Move cell tool
Random tool
Rows

Spin tool
Spreadsheet
Timer

Databases

>

Search a database in order to answer questions
correctly.

Avatar
Charts




Enter information into a class database.
Understand how to word questions so that they can
be effectively answered using a search of their
database.

Database

Sort, group and arrange
Statistics and reports
Table

Collaborative

Data

Find

Binary Tree

Record

Game Creator

YV VVY

Review and analyse a computer game.

Create settings and characters for games.

Use animations and sounds to develop characters.
Create a game and instructions for it.

Animation
Evaluation
Interactive
Perspective
Computer game
Image
Screenshot
Customise
Instructions
Texture
Playability

3D Modelling

VVVYVY

Understand how to use 2Design and make
Explore moving points on a design

Design for a purpose

Print 2D designs to create 3D designs

CAD 2D
Points
Modelling
Viewpoint
Net
Template
3D

Polygon

3D Printing

Effective Searching

Create concept maps to express ideas.
Use concept mapping to create a piece of writing.

Audience
Concept Map
Node
Collaboratively
Connection
Thought
Concept

Idea

Visual
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Year 6

functions.

National Curriculum Objectives Strand Unit

Design, write and debug programs that accomplish specific goals, including Computer Science 1,5,9

controlling or simulating physical systems; solve problems by decomposing

them into smaller parts.

Use sequence, selection and repetition in programs; work with variables and Computer Science 1,5

various forms of input and output

Use logical reasoning to explain how some simple algorithms work and to Computer Science 1,5,9

detect and correct errors in algorithms and programs

Understand computer networks, including the Internet; how they can provide | Computer Science 2,4,6

multiple services, such as the World Wide Web; and the opportunities they

offer for communication and collaboration.

Use search technologies effectively, appreciate how results are selected and Information technology 2

ranked, and be discerning in evaluating digital content

Select, use and combine a variety of software (including internet services) on Information technology 1,3,4,5,7,8

a range of digital devices to design and create a range of programs, systems

and content that accomplish given goals, including collecting, analysing,

evaluating and presenting data and information.

Use technology safely, respectfully and responsibly; recognise Digital literacy 2,4

acceptable/unacceptable behaviour; identify a range of ways to report

concerns about content and contact.

Term Focus / Activities / Resources Knowledge, Skills, Understanding Key Vocab

1 Coding » Debug when things do not run as expected. Action
» Explain what functions are and how they can be Alert

created and labelled. Algorithm

» Code programs that take text input from the user. Code design
> Follow flowcharts to create and debug code. Command
> Explain how they organised code in a program into Control

Debug/Debugging
Event
Flowchart bug




Get input

Function
If
If/Else
Input
Output
Repeat
Simulation
Tabs
Selection
Online Safety and Spreadsheets » Understand how what they share impacts upon Digital footprint
themselves and upon others in the long-term. Phishing
» Know about the consequences of promoting Password
inappropriate content online and how to put a stop Screen time
to such behaviour. Spoof website
> Give reasons for limiting screen time. PEGI rating
» Create a spreadsheet to answer a mathematical Average
question relating to probability. Advance mode
» Use the formula wizard to create formulae. Copy and paste
> Use a spreadsheet to solve a problem. Columns
» Use a spreadsheet to model a real-life situation and Cells
come up with solutions that can be applied to real Charts
life. Dice
Equals tool
Formula
Formula wizard
Move cell tool
Rows
Random tool
Spreadsheet
Timer
Spin tool
Databases » Understand how a blog can be used for information. | Audience
» Work collaboratively Blog
> Create blogs for specific purposes. Blog page
» Understand that blogs need to be regularly updates. | Blog post
» Post comments on blogs. Collaborative

Icon




Demonstrate awareness of inappropriate posts and
cyberbullying.

Text Adventures > Map out a story-based text adventure. Text based adventure
> Use the full functionality of 2Create a Story Concept map
Adventure mode to create, test and debug using Debug
their plan. Sprite
> Use coding concepts of functions, two-way selection | Function
(if/else statements) and repetition in conjunction
with one another to code their game.
Networks » Know the difference between the World Wide Web Internet
and the internet. World Wide Web
» Know about their school network. Wide area network
» Consider some of the major changes in technology Network
which have taken place during their lifetime and the | Router
lifetime of their teacher/another adult. Network Cables
Wireless
Quizzing » Have ideas about what sort of questions are best Audience
suited to the different question types. Collaboration
» Used 2Quiz to make and share a science quiz. Concept map
» Used a 2Investigate quiz to answer quiz questions. Database
» Design their own quiz based on one of the Quiz

2Investigate example databases.




